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I. Introduction:

There's is a common saying among IT specialists: backups are most commonly done the day after a disk crashes. Sad, but true –  try not to let that happen to you. Modern computer hardware is a miracle of technology, and extremely reliable in relation to the  complexity of the underlying mechanisms,  but it is not foolproof. Bad things happen on occasion. Disks crash. Errors are made. Uninterruptable power supplies get interrupted. Data gets lost as a result. The IT group backs up critical files (home directories, system files, etc) on a regular basis. However, due to the large size of the CDC storage pool  we do not have the manpower nor the resources to back up everything every night. Some file systems are backed up nightly. Others are only backed up on a monthly basis. Still others are not backed up at all. Please see: 

    
http://www.cdc.noaa.gov/systems/policy.html#backups

For the current backup schedule. It is up to you, as a user, to understand the backup schedule and policy and use the various tiers of storage available appropriately.  

Even with this, there are going to be times you have large datasets on storage that is not backed up by the IT group, or when you have done a large amount of work and the file system you've been working in is not scheduled to be backed up again for some time. For those occasions, CDC has a number of user-initiated backup facilities available. Even if  the filesystem in question is backed up regularly, for particularly valuable data that could not be replaced, it is not a bad idea to create your own backup as well. Remember, YOU are ultimately responsible for your own research results and data. And in this situation, paranoia is healthy.

II. Backup technologies available:

OK, enough with the scare tactics. Time to do some backing-up. How? Where? On what? This document will describe several different means available to  CDC members for backing up all the data they have acquired. These include:

a. DVD:

CDC has several different machines available that allow you to create your own DVDs.  DVDs cost approximately $0.75 and hold approximately 4.3 gBytes. The estimated life span of a user-written DVD is around 100 years. You cannot rewrite to a DVD nor change the information that's on the DVD in anyway once it's written. Transfer rates (for 8x drives, of around 10 mBytes/sec) – not too bad on the face of things, but because of the other operations involved in creating a readable DVD, the actual time to burn a CD is usually around 30 mins.  For small amounts of high-value data that you want to keep for a long time (for instance, that proposal you just finished, paper you just submitted, or computer program you just wrote), a DVD might be the best solution. They're also relatively cheap and easy to mail across the country (and world). With some care, DVDs can be created on any  of the “big 3” operating systems that will be readable by other operating systems, so they make a good medium for collaboration and sharing of results with others.

b. Tape (DLT and LT02) 

DLT tapes are the most readily available media to backup to, and provide the most   capacity / $ of all backup technologies. They've been around the longest (as a viable back up solution), and we have a number of different tape drives available. DLT tapes hold 35 gBytes uncompressed, and cost approximately $50/tape. CDC just recently added 2 HP Storageworks Ultrium 460 LT0-2 drives to its hardware inventory – these newer technology drives hold 200 gBytes uncompressed, and cost approximately $60/tape.  DLT drives typically have about 5 mByte/sec performance, while LT02 can go up to 60 mByte/sec.

The decision to compress or not compress data prior to copying to tape is an individual one – the drives themselves can do an LZW algorithm compression, 
like the Unix compress command. If you have only a few large files, the 
results will probably be better if you run a newer compression program, such as bzip2 on them beforehand. On the other hand, if you are backing up many small files, the streaming LZW compression  on the drive itself may actually perform better.

Tapes typically have around a 15 year shelf life. For relatively economical, long term storage of intermediate to larger sized datasets, tape is still a very viable alternative. At this point, tape drives are available from the Solaris systems only.

c. External hard drive (grant funded):

The fastest, most “hands free” backup technology is probably an external hard drive. With the prices of firewire enabled drives coming down quickly, hard drives are approaching a cost per gigabyte where they are economically competitive with tape.  External firewire drives are available in capacities ranging from 80 gBytes to a tByte, or more, with costs ranging from $120 to $900. Transfer speeds across a firewire interface range from 250 mBytes/sec to 500 mBytes/sec – much, much quicker. Although we have firewire ports available on all of the “big 3” operating systems (Linux, Windows, and Macintosh), drives aren't really portable from one to the other, (filesystem layouts – the way the operating system actually puts the information on the disk – differ from OS to OS), so it's best to stick to one platform or another for backup and retrieval of data.

And, of course, a hard drive is subject to all the reliability concerns of the original system you're backing up: to be safe, turn on the external drive only when you're backing up or retrieving from it, keep it in a safe, dust-free place, and avoid jostling it too much (i.e. keeping it in the trunk of your four-wheel drive jeep is not recommended). And above, all, use it as a backup device only – that means nothing should be on there that is not available, under normal circumstances, somewhere else.

External drives, although becoming more economical, are still relatively expensive. Because of this, the IT group cannot supply external drives to every research group or CDC member who would like to backup data. External drives must be bought through individual research grants only.

d. Comparison of available backup technologies

In summary, here are the main attributes of the various backup technologies available at CDC:

	
	DVD
	TAPE 
	External Drive

	
	
	 DLT
	LTO2
	

	Capacity (uncompressed)
	4.3  gBytes
	35 gBytes 
	200
gBytes
	80 gBytes – 1 tByte

	Cost
	$0.75
	$50.00
	$60.00
	$120-$900

	Cost/gigabyte
	$0.17
	$1.40
	$0.30
	$1.50-$1.10

	Typical transfer rates
	10 mBytes/sec
	5 mBytes/sec
	60 mBytes/ sec
	250 mBytes/sec  - 500 mBytes/sec

	CDC supplies media?
	Yes
	Yes
	Yes
	No

	OS's supported
	Mac, Linux, Windows
	Solaris
	Solaris
	Mac, Linux, Windows


Blank tape media are generally available from the main CDC office – blank DVD and CD media are available from the IT group.

III. Detailed Instructions

Detailed instructions for each technology are included in the following sections.

a. Backing up to tape

1. How to back up to tape (Solaris)

CDC has a number of tape drives available for your use:

	Room
	Machine 
	Drive (s)

	1D-601
	tape-601
	2 DLT

	
	
	1 LTO2 

	1D-611
	tape-611
	1 DLT

	
	
	1 L280 DLT stacker 

	1D-701
	tape-701
	2 DLT

	GD-403
	tape-403
	1 DLT

	
	
	1 L280 DLT stacker 

	
	
	1 LT02


The L280 stackers provide the same tape technology (a single DLT 7000 drive) as the standalone drives, but they can hold up to 8 tapes at a time and will sequence through the tapes as needed.

All of the tape machines run the Sun Solaris OS. On Solaris, we have a suite of local tools available for dealing with tapes and for protecting the contents of your tape from being overwritten by other users.

The tools display_tape and assign_tape have man pages for the details. In general, display_tape shows you who is using the tape drives on the local system (tape-601, tape-611, tape-701).  Assign_tape is used to give you temporary ownership of a drive.  In addition, there are few more commands developed locally that use these two commands.

First, there is unassign_tape, which should be self-explanatory. Also, there is eject_tape, which offlines (explained below) a tape drive and unassigns it so others may use that drive.  Finally, the command avail_tape will check each of the tape hosts for available drives. By default, it does both DLT and 8mm (not described) here, but can be limited to DLT drives by specifying either “dlt” or “DLT” as an argument. Unfortunately, due to technical limitations, you will be required to type your password multiple times.

The general tape operations command “mt” has a man page showing many possible uses, two of which are useful for backing up data. First, to check if the tape (assumed to be device 0 for this example) is ready for use, try:

mt -f /dev/rmt/0bn stat

(This parenthetical note is for those who need details; others may skip it.  The “b” suffix after the drive number specifies Berkeley EOF semantics, which won’t be a factor in most backup scenarios, while the “n” suffix indicates no-rewind mode.  Again, this shouldn’t be needed in most backup scenarios, but it’s probably best to be in the habit of always using both suffix flags to avoid problems, and they never hurt.)

The other mt operation useful for backup work is the offline command:

mt -f /dev/rmt/0bn offl

Which makes the tape ready for removal from the tape drive. The tape will be rewound, as it is not possible (without disassembly) to remove a tape from one of our drives that is not rewound.

For single volume backups, a very simple tar command line will do the

job:

tar -cvf /dev/rmt/0ubn <directory_to_backup> |& tee <tape_log_file>

A couple of notes about the above command:

1) The “u” suffix after the drive number specifies compression, which will maximize the capacity of a DLT; you might get more than 35 gBytes on one with this flag.

2) <directory_to_backup> should be either the current directory or below the current directory.  If you want to back up the current directory, use “.” for this argument.

3)The |& is csh/tcsh for “pipe standard output and error output to this command”.  On other shells, it might be 2>&1 | .

4)The tee command and it’s <tape_log_file argument> (which should NOT be under <directory_to_backup> provide a list of what files are on the tape you make.  With the tee command (rather than just redirecting the output to a file), you can see the progress of your tape job as well as have a record.  Also, when you restore from this tape, you will need to specify paths exactly as in this listing (assuming you don’t want to restore the whole tape, which would take a lot longer than it took to write it).

So, a typical scenario would be:

A) login to a tape host, possibly after using avail_tape to select it.

B) cd to a directory containing the stuff to back up.

C) display_tape to see what drives are open.

D) assign_tape to grab a drive.

E) Physically insert the tape into the drive.

*F) Use mt -f /dev/rmt/0bn stat to verify tape is loaded and ready.

*G) tar command as above.

*H) eject_tape /dev/rmt/0bn

I) Physically retrieve your tape from the drive.

The letters with asterisks preceding them indicate where the drive number used in the command will need to be changed to that of the drive you assigned.

2. For advanced users:  multi-volume backups

Sometimes you may need to back up significantly more than 35 gBytes. It’s recommended that you avoid this by breaking things up into smaller backups, and backing up as you add chunks <= 35 gBytes.  However, if you want to try this, here’s a gtar command that might help:

gtar -M -cvf /dev/rmt/0ubn <directory_to_backup>

This command will prompt you to change the tape when one is full. You have to manually offline and change the tape (mt’s offline operation can be used from another window, of course).  The L280 stackers on both tape-611 and tape-403 are useful in such an effort.  After each tape change, it’s good to use mt’s stat command to verify readiness again from another window.

b. Backing up to DVDs:

This section will be broken down into three subgroups depending upon which type of machine you have chosen to write your DVDs on: Linux, Mac OS X, or Windows 2000.  All three hardware platforms suffer the same problem, DVDs are only capable of holding 4.3GB of data (not the advertised 4.7GB!).  New technology has emerged however, not truly available yet, that offers capacities of 8.3GB and 27GB – still vapor ware.  So, the problem resides in your ability to break your data into groups of 4.3GB or less.  One strategy is to put your data into a directory and run du –sk <directoryname> to see how much you have in there, then add or remove files until you are close to the current 4.3 gByte limitation. Depending upon your file sizes, it might be possible to partition your data into a number of directories, each of which is less than 4.3 gBytes, each of which can then be backed up on it's own DVD.

1. How to backup to DVD (Linux):

The Linux system in  room 611 (called, appropriately enough, linux611) has a DVD burner capable of burning the most common DVD formats: DVD+R, DVD-R, DVD+RW, and DVD-RW.  Blank DVD's can be obtained from the CDC IT group.

It takes approximately 30mins just to burn a full DVD (~4 gBytes) (not including the time it takes to copy the files via the network).  

Also, the DVD burner can burn CD-R and CD-RWs. Since CD's hold considerably less data (about 650 mBytes) than DVD's, burning DVD's is probably preferable. However, if you have < 650 mBytes of data to backup, or want to use up some blank CD media you have, the steps below will work the same for DVD's and CD's.

Note: Linux systems often come with different windowing systems, the most popular being “KDE” and “Gnome.” Linux611 supports both of these systems. The steps listed below assume you are using the Gnome windowing system – for KDE user's, the steps will be similar, but may differ in the details.

If this is your first time using linux611, there a steps you can take to insure you login under the Gnome window manager. If it is not, and you have accomplished the steps below previously, you should automatically come up under the GNOME window manager (if there's a “Foot” icon in the bottom left hand corner of the screen, your using Gnome.)

Switching to GNOME for first time users, or for KDE users wanting to switch to Gnome:


1. On the login screen, click on Session at the bottom of the screen, and select GNOME from the list.  Click OK.

2. Login on the console with your Solaris (UNIX) username and password.

3. When the login completes, you should see a foot icon in the lower left of the screen, click on that, and select System Tools -> Terminal from the menu.

4. When the terminal window appears, type:



switchdesk-helper GNOME



and hit return.  It should respond with:



Desktop now set up to run GNOME.

5. Click on the foot icon in the lower left of the screen again, and select Logout.  In the window that appears, select Logout and click OK.  This will return you back to the original login screen. Please continue with the instructions below to burn a DVD.

Creating a DVD or CD under Gnome on Linux 

1. Login on the console with your Solaris (UNIX) username and password.

2. When the login process completes, place a blank DVD or CD into the DVD burner and close the tray.  A window titled CD/DVD Creator should appear shortly.  Drag this window over to the upper right side of the screen, as you'll need this again later.

3. Double click on the Home icon on the desktop.  A window will appear with a graphical inventory of your home directory.


This is where you will choose the files and 
directories that you want burned onto a DVD or CD.  (If you have CD or DVD disk image, often referred to as a ISO file, that you wish to burn onto a disk, then skip to the addendum at the end of this file.)


To add files to be copied, just drag and drop them into the CD/DVD Creator window. This physically copies the files into a special place for creating the DVD and may take a few minutes depending up on the sizes and number of files. Alternatively, the CD/DVD Creator software understands links, so you can select files, then select Make Link from the File menu of the same window. This will create a file with the name Link to <file or directoryname>. Copying that link file into the CD/DVD Creator window has the same affect as copying the entire file, and might be considerably quicker.

  If you wish to make multiple directories on the disk, click File->Create Folder in the CD/DVD Creator window. 


If you wish to copy files from filesystems other than your home directory, then click on the drop down box next to your username in the lower left hand corner of the window, and scroll up to the / directory.  Another window showing a listing of / will appear, and you can double click into the directory structure that you want to copy files from (/data, /nas, /scratchXXd, etc.)


Note: because all of your filesystems are likely mounted via the network, dragging and dropping them into the CD/DVD Creator window will be a slow process, so please be patient.


Once you have the files and directories in the CD/DVD Creator window appearing as you want them to on the disk, click File->Write to Disc.


4. In the window that appears, edit the Disc name field to your liking.  You also might want to consider decreasing the write speed because the slower you write the disc, the better the chance that a regular DVD-ROM or CDROM drive will be able to read the disc, particularly on older models.  The obvious trade off is that it takes longer to write the disc.


 Select Eject disc in the dialog for actions to take after burning.


Click on Write.  This will take a long time, so you can click on the foot icon, select Lock Screen and leave the workstation.  The disc will eject when it is finished, so be sure to wait until that happens.  When that happens, it's best to insert the disc back into the machine, and when the disc appears on the desktop, browse through it to make sure everything looks as it should.  Right click on the disc icon and select Eject to eject the disk.


Make sure to logout when finished burning a CD or DVD.

Addendum: Burning a Disk Image to a CD or DVD

(This is only relevant if you have a file with .iso extension or that you 

know is a disk image. In this case, the file represents exactly what should be written to the disk with no formatting or translation necessary. If you do not have a .iso file or a file you are sure is a disk image, skip this section).

1)  The process for burning disk images is similar, however, because the file is a disk image you don't need to collect files to burn to the CD/DVD as they are already contained within the disk image (or ISO file).  To burn the image to a disc, right click on the image file, and select Write to Disc.  Then follow the instructions in Step 4 above.

2. How to backup to DVD  (Windows):

The Windows system in  room 601 (called, appropriately enough, 601_PC) has a DVD burner capable of burning the most common DVD formats: DVD+R, DVD-R, DVD+RW, and DVD-RW.  Blank DVD's can be obtained from the CDC IT group.

To backup files from your Unix home directory, you will need to have your Unix  home mounted (i.e. made available) on the Windows machine.  CDC IT runs special software on the Unix machines, called “Samba” to allow this to happen. The default within CDC is to mount home directories on Windows machines under the drive letter G. 

If you don't have a drive letter G: showing up in the Windows Explorer with your Unix files in it, you'll need to mount your Unix home directory:

Mounting a Unix home directory on Windows:

1. right click My Computer and from the menu select: 
Mount network drive.


2. In the resulting pop up window, select:


 drive letter G:  for drive 
your samba home mount point for Folder 

Aside: How to find your  samba home mount point:
All Unix home directories are mounted as part of the home1 or home2 filesystems on Unix. To find out whether you are on home1 or the home2 filesystem, in a Solaris terminal (note, from 601_PC you can bring up a “command line window” and ssh to any of the Solaris machines, int1, int2, etc.), execute the command:

grep <username> /etc/auto_home


Once you've found out which filesystem your on, the samba home mount point is as follows:

for users on home1: \\home1\username 
for users on home2: \\home2\username 

3. Select the “Reconnect at login” option and click “Finish”

Creating a DVD or CD under Windows:

1) Login to the PC.

2)  Run Veritas RecordNow DX  by selecting, from the Start menu:
Start  
 
Programs  

 
Veritas Software  
 


RecordNow DX  
 



RecordNow DX

3)  When the program is finished opening, click Make Data Disc.

4) The Veritas RecordNow GUI will then guide you through  the remaining steps:

a) insert blank DVD/CD
b) selecting files to write to the  DVD/CD.  Note the Space Remaining tally in the window.
c) Burning/Writing your DVD/CD


5) Don't forget to eject your disk, take it with you, and log out of the PC 

when done.

3. How to backup to DVD (Macintosh OS X)

The Macintosh system in  room 601 (called, for absolutely no good reason we can think of Mac22) has a DVD burner attached to (on the table, not physically in the box itself). capable of burning the most common DVD formats: DVD+R, DVD-R, DVD+RW, and DVD-RW.  Blank DVD's can be obtained from the CDC IT group.

Creating a DVD or CD under Macintosh OS X

1. Login to the Macintosh and place a blank DVD in the DVD drive.

Depending on selections you’ve made (or not made) in the past, the Mac may bring up a variety of software packages to write your DVD.  We recommend Roxio Toast 6 Titanium over the built in Macintosh OSX DVD burner, although either will work.  If you are already familiar with using the system supplied software, by all means continue to do so. For others, this tutorial will explain how to use the Roxio Toast application.

2. If the Macintosh system-default DVD burner came up upon placing a DVD in the drive,  close the application.

3. If Roxio Toast 6 Titanium didn’t come up for you automatically, start it manually: From your finder navigate your way:  Mac OSX  Applications  Roxio 6 Toast Titanium  Roxio Toast.

4. In the Roxio Toast window, click on “Data”

5. Drag Files/Folders to Toast (your Unix home should be auto-mounted on the desktop for you). 

6. When done, Click the Red circle at the lower right corner of Roxio Toast window.

7. On the pop-up window click Record

8. After recording is complete a pop-up window will give you the opportunity to skip verification and eject, if you do nothing, it will “verify” the disc (takes almost as long as the actual burn, and as of today, in the many DVD’s/CD’s I’ve burnt in this manner – none have failed verification.)

9. If you chose to verify and not eject in step 5, when the verification is complete the DVD will appear on your desktop.  To eject drag it to the trash can, this will not delete it but, eject it.

10. Don't forget to take your newly minted DVD with you and logout of the Macintosh before leaving.

c. Backing up  to an external Fire Wire Hard Drive:

This section will be broken down into three sections, depending upon which type of machine you have chosen to connect your fire wire hard drive to: Linux, Mac OSX or Windows 2000/XP. 

Since these drives are currently available in capacities ranging up to 1 TB this will be the easiest method to backup your data.  NOTE: once you have decided on a platform, you are somewhat married to it, unless you are willing to reformat the drive (losing all the data previously put on it) for use on a different platform. This is because to be useful for holding data a drive has to be formatted using a particular filesystem (a standard way laying out the bits on the drive so the operating system can later tell what's where and how to get the information back off). Unfortunately, different operating systems use different filesystems, and are more, or less, able to read each others.

The Windows XP/2000/NT4.0 preferred filesystem, NTFS, can be read (not written to) from Linux, and FAT (DOS file format) and FAT32 (DOS extended file format) can be read and written to in both Linux and Windows.  

Nevertheless, CDC IT does not recommend trying to use external hard drives across platforms – choose a platform to read/write from, and stick with it. Note that this doesn't mean you can't back up your Unix home directory from, for instance, a Macintosh – network protocols allow us to mount filesystems from certain machines onto other machines running different OS's – in this case, however, the “native” OS is actually reading the bits as a favor to the client OS and sending the bits to the other OS across the network. This is what allows you to mount your Unix home directory on a Windows machine, on a Linux machine, and on an Macintosh.

The following file formats are recommended for your use (depending again on the chosen platform):

	Platform
	recommended file format

	Mac OS X
	Mac OSX extended

	Windows (2000/XP)
	NTFS

	Linux
	ext3


A word of caution: However tempting it might be to take this hard drive traveling or home with you, remember, this is your backup!  The safest place for it is in your desk drawer or on a shelf.  Every bump/vibration the drive encounters could damage it and the data on it.  As well, if you take it off site and use it with another machine, you may inadvertently acquire a virus/worm and bring that back to CDC or  lose or damage the drive.  So, given that you won’t be doing that (right?)… the choice is simplified by which platform appears to be the simplest to use and which you are most familiar with. If your unfamiliar with all 3, or don't have much of a preference, the Macintosh might be a good place to start.

For all platforms the first step will be to partition and format the drive. This only needs to be done the first time you used the drive.  Next you will mount the drive (automatic in Mac OSX and Windows).  Then finally, you can  begin copying your data to the drive.  The subgroups below will describe each platform in detail.

1. How to backup to an external drive  (Macintosh OS X)

Preparing the disk for use (partitioning and formatting)

Connect your fire wire hard drive to the machine and power it up. 

Some manufacturers who aim primarily at the Macintosh market and thus sell their already formatted in Mac OS X extended format, If you have purchased a LaCie external fire wire drive,  it is ready to use after you plug in the power and fire wire connections – nothing more needs to be done. If the drive has already been formatted (in a Macintosh OSX format – like OSX extended) it will appear in the Finder -  the Mac's filesystem browser and desktop GUI - and is ready to use.  

If it hasn’t already been formatted in a Macintosh format, it will not appear in the Finder.  If this is the case you will need to run the Macintosh disk utility to partition it and then format it. 

1) From the Finder, navigate to: 

MacX  


Applications  



Utilities  




Disk Utility

2) From the Disk Utility program click on the new disk, possibly labeled untitled (NOTE BENE: Not “MacX” or “Backup” - these are the system disks).

3) Use the pull down menu in the Disk Utility program  under “Volume Scheme” to select “1 partition”.  

4) On the right side under Volume information in the name field enter a name that you would like disk labeled as – this is the way it will appear in the Finder from here on out. One recommendation is to give it your name or userID – that way if you forget and walk away leaving the disk mounted one day we'll will know who it belongs to.  

5) Use the pull down menu under Format to select Mac OSX Extended.

6) Click Partition in the main Disk Utility window.

7) A pop up window will ask you to confirm your selection – double check that your partitioning the right disk and not any of the system disks, then click partition again.

8) The drive will now be partitioned and formatted for use and should appear as an icon on both the Macintosh desktop and the Finder windows.

Backing up to an external drive under Macintosh OSX

There are several ways to copy your data to the fire wire drive, the simplest is drag and drop.  If you want to create an exact mirror of your data that will be easily appendable to this drive you may wish to use psync.  The advantage to using psync  is that it will compare what is already on the fire wire drive to what you are mirroring and only copy over what has changed or what it doesn’t already have on it – much faster than recopying all of your data (provided it already has some of it on there – if it’s a new drive with nothing on it, the drag and drop method will probably be faster.)

For example if you run (from a terminal window on the Macintosh):

psync -q <dir1> <dir2> 

This will copy over all new files from <dir1> to <dir2> (note it won’t copy the files you already have ;) and not give you any feedback.

psync -d <dir1> <dir2>

This will copy over all new files from <dir1> to <dir2> and DELETE files from <dir2> that don’t exist in <dir1>.

2. How to backup to an external drive  (Windows 2000/XP)

The Windows system in  room 601 (called, appropriately enough, 601_PC) has  firewire and USB ports available on the (actual) desktop.

Preparing the disk for use (partitioning and formatting)

Under the Windows operating system, formatting a hard drive unfortunately requires Administrator privileges. Luckily, you only have do this once - please bring it to a member of the IT group and we'll get it formatted for you.

Mounting a Unix home directory on Windows:

To backup files from your Unix home directory, you will need to have your Unix  home mounted (i.e. made available) on the Windows machine.  CDC IT runs special software on the Unix machines, called “Samba” to allow this to happen. The default within CDC is to mount home directories on Windows machines under the drive letter G. 

If you don't have a drive letter G: showing up in the Windows Explorer with your Unix files in it, you'll need to mount your Unix home directory:

1. right click My Computer and from the menu select: 
 Mount network drive.

2.  In the resulting pop up window, select:


 drive letter G:  for drive 
your samba home mount point for Folder 

Aside: How to find your  samba home mount point:
All Unix home directories are mounted as part of the home1 or home2 filesystems on Unix. To find out whether you are on home1 or the home2 filesystem, in a Solaris terminal (note, from 601_PC you can bring up a “command line window” and ssh to any of the Solaris machines, int1, int2, etc.), execute the command:

grep <username> /etc/auto_home


Once you've found out which filesystem your on, the samba home mount point is as follows:

for users on home1: \\home1\username 
for users on home2: \\home2\username 


3.  Select the “Reconnect at login” option and click “Finish”

Backing up to an external drive under Windows 2000/XP

1. Login to Windows on 601_PC

2. After the login is finished, plug your formatted drive into the firewire or USB  port on the desk.

3. Within a few seconds the drive should appear under My Computer, when it does, it is ready for read/write access.

4. Copy the files you want backed up to the external drive mounted on the Windows system.

5. Logout of the Windows system.

6. Power off your drive, disconnect it, and store it in safe place.

There are several ways to copy your data to the fire wire drive, the simplest is drag and drop. Assuming you have your UNIX home mounted on the 601_PC as drive G: (see above),   the easiest way to get to your /data, /nas, or 
/<whatever_you_want > is to make a link out of your UNIX home (from a Solaris terminal or, ssh'ing to a Solaris box from a Command Line window on the PC) pointing at your desired data.  IE:  

ln –s /nas/<username> /home/<username>/nas

Will create a pointer to /nas/<username> from the users UNIX home.  Then, from windows, it is possible to navigate to drive G: and dbl click the nas directory, leading to the /nas/<username> directory and contents.

Another option is to run rsync on windows, which allows remote copying and mirroring of directories from one filesytem to another. The advantages of rsync over drag and drop is that rsync will figure out the details for you, and only copy over the files that have been changed since the last time the two filesystems were rsync'ed.  Since this involves some detailed set up on both the Unix and Windows sie, please see someone in the IT group for instructions.

3. How to backup to an external drive  (Linux)

The linux system in room 611 (called, appropriately enough, linux611) has a firewire port available on the (actual) desk.

Preparing the disk for use (partitioning and formatting)

Under Linux partitioning and formatting are root commands so, you won’t be able to do that yourself on our Linux machines.  Luckily, this is a one-time operation, so just bring it to one of the IT group and we’ll partition/format for you. Once setup on linux611 we can make the device automount once plugged in.

Backing up to an external drive (Linux)

Copying from Linux611 to your firewire drive can be accomplished in a multitude of ways.  The most popular window mangers, Gnome and KDE, both provide file managers that allow drag and drop copying of files from one filesystem to the other. 

Another option is to use the  rsync  command from a shell, which allows remote copying and mirroring of directories from one filesystem to another. The advantages of rsync over drag and drop is that rsync will figure out the details for you, and only copy over the files that have been changed since the last time the two filesystems were rsync'ed. 

rsync is a powerful tool with a large number of options, many of which are overkill for the purposes of this document. To get a full explanation of the rsync command, please see the system man pages (type man rsync from a shell prompt). A few very simple things you can do:

rsync -r <dir1>/ <dir2>

Will copy (recursively) the contents of dir1 into dir2. Note the trailing slash after <dir1>/ without it, rsync will reproduce the source directory into the target, instead of just the files contained therein. I.E., if you had:

dir1/frank

dir1/fred

dir2

After rsync -r <dir1>/ <dir2>, you would have

dir1/frank

dir1/fred

dir2/frank

dir2/fred

While after rsync -r <dir1> <dir2>, you would have

dir1/frank

dir1/fred

dir2/dir1/frank

dir2/dir1/fred

Another option of interest is the --delete option:

rsync -r --delete <dir1>/ <dir2>

Copies everything from <dir1> into <dir2>, and DELETES everything in <dir2> not in <dir1>. Note that this is a very powerful, but dangerous, command. Make sure you understand in which direction the copy is proceeeding before inadvertently deleting all your files newly created since your last backup. The prudent thing to do is to use the “dry run” (-n) option first, to see what will happen prior to actually executing the command.

rsync -r -n --delete <dir1>/ <dir2>

Will not actually execute the command, but will give you a listing of what would happen if you executed the command without the dry-run option.

After copying your date to you new hard drive, the best thing to do is unmount your new drive from the Linux machine:

umount <drivename>

Then, logoff the linux machine, unplug your hard drive, and store it in a safe place.
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